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BEST PRACTICES COURSE – WEEK 17 – Complex Modeling PART 1- 
Solid Element Operations 
 

Hello, this is Eric Bobrow.  In this lesson, we'll take a look at one of my favorite topics in all of ArchiCAD, 

Solid Element Operations.  Now here we are in the Best Practices course, and when I go down to the 

outline, it's week 17; although as you all know it's taken much longer to get to Solid Element Operations 

and to this week than 17 weeks.  But this is actually a topic that I wrote about way back in 2006.  It was 

the very first tips and tricks article that I published on AECbytes. And you can find it there on AECbytes 

or on Bobrow.com under my ArchiCAD tutorial articles. [0:00:41]   

Now Solid Element Operations actually did not start back in ArchiCAD 10 when I wrote about it; they 

started way back in ArchiCAD 8.  This is an article in CAD Digest that was published back in 2003 by three 

ArchiCAD veterans: David Pacifico, Robert Bissett, and Carl Ottenstein. It's not a very long article, just a 

few paragraphs and a couple of images.  But basically, they explain some of the concepts there when it 

first was introduced.  [0:01:13] 

Now I've done a lot of work with Solid Element Operations.  It's so useful in so many ways.  There's 

another tutorial video that I created in 2010 that is about how to use Solid Element Operations in 

complex profiles in terrain modeling.  I will put a copy of that on this same lesson page for easy 

reference there.  [0:01:34] 

Now let's take a look at the basics of using ArchiCAD Solid Element Operations.  Here we have the 

project that I used in the original article; that's a residential design by some California architects that 

Graphisoft got the rights to use for webinars back in ArchiCAD 9.  And so here in ArchiCAD 10, I used 

that particular file.  Now you'll see that as I zoom in on it, there are some grooves in the wall, and that is 

something that I added to this design as part of demonstrating this concept. [0:02:09]   

Now, the grooves are created using Solid Element Operations where one element is subtracted out from 

another.  That's probably the most common thing or most obvious way to demonstrate Solid Element 

Operations, so I'm going to show you how that works.  I'll go and draw a slab and we'll take that slab and 

I'll stretch this edge into the building in a way that shows very clearly that it's sticking into the wall.  

Then I'm going to go to the Design menu and open up the Solid Element Operations palette.  [0:02:47] 

In ArchiCAD 10 through 14, it was found here in the Design menu under Complex Profiles about halfway 

down.  In ArchiCAD 15 and 16 it moved around a little bit, and I will see that a little bit later in this 

lesson.  Now, in order to work with Solid Element Operations we need an operator.  I'm going to select 

the slab and then click on Get Operator. That means that this slab is going to operate on one or more 

other elements.  It's going to control the action.  Then I will select in this case the wall and make it the 

target.  [0:03:19] 
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Now I will zoom in on it a little bit.  You can see the outlines for the wall.  When I choose subtraction as 

the operation, it will subtract out the slab volume from the wall.  And you'll see the green lines change.  I 

will say execute, and you can see the green lines changed, reflecting that hole.  Now we're not actually 

seeing the hole very well because the slab is there.  If I were to delete the slab, select this and delete it, 

the hole goes away.  So how can you see it without the slab being there?  Let me undo the deletion 

here.  [0:03:56] 

We can hide the layer that the slab is on.  So I'll go and use the Window menu, Palettes, Quick Layers to 

bring up the Quick Layers palette; select this slab and then tell ArchiCAD to hide the layer that that 

selection is on.  And now you can see the slab has disappeared as well as the actual floor of the building, 

and we can see that hole.  Now if I use the Quick Layers palette, the one reason why I prefer this is 

because I can undo the quick layer actions. So now the layer is turned back on again instantly.  [0:04:31] 

If I were to take this slab and for example make it thicker, raise its height up here and then we were to 

again hide it, we can see that the relationship was lingering.  In other words, wherever the slab is, 

however thick it is, whatever position it is, it will be continuing to cut that wall.  We could hide and show 

the layer elements on that layer in order to manipulate this, but there is a way that we can do 

something where we can see it and see through it.  I'm opening up the Layer Dialog box. The slab is on a 

layer called Floors.  I'm going to click on this little icon here in the layer list and I will make it wire frame. 

[0:09:51]  

You notice if I click again it's solid, click again it's wire frame.  So now made it wire frame and we can 

now see through this as well as of course the other elements on that layer, in this case the real floor 

slab.  So if I select this, I can actually manipulate it just like we would in any other case, and I've just 

made it wider.  I could take the bottom up like this.  And so basically I can manipulate this even in this 

mode.  [0:05:47] 

Now let's say that we wanted to undo this.  In other words, prevent it from cutting into it.  How would 

we do that?  Well, if I select this element you'll notice that below the first half of the new operations 

that are in the Solid Element Operations palette, there is a Maintain Operations group.  And I'd like to 

say how is this related to other elements?  Perhaps I want to cancel the operation of the selected 

element, in this case the slab on other elements that have been its target.  [0:06:21] 

So I can say cancel this. And you can see as soon as I click the button on all targets, then the wall heals 

itself.  So this is one way that you can manage it.  It actually became a little easier to see these 

relationships in ArchiCAD 15 and 16, and I'll show you that a little later in this lesson.  I wanted to 

demonstrate that if I take this in let's say to the edge of the window and snap it, you can see now I have 

this volume passing through the window.  The question is can I, whether this layer is wire frame or not, 

can I trim this out of the window?  [0:07:01] 
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Well I can select this element here and tell it that I'd like to make it the operator, and then I can try to 

select the window and make it the target, but when I click you'll notice that it stays zero.  I can click as 

many times as I like; the window is not eligible for being trimmed.  If I click on Execute at this point it will 

say there are no valid target elements stored.  So how could I do it?  If I for some reason wanted to trim 

a volume out of a window or door and I've have that question come up for certain types of modeling 

operations, perhaps making an ornate molding or something like that.  [0:07:43] 

Well the answer is we can select the wall and make it the target and any element that we want for an 

operator and then execute this. You'll see how it has trimmed out of the window.  So instead of telling it 

to trim the window, you tell it to trim the wall and perhaps if you want you can make this just a very 

precise piece that cuts only out of the window area.  Now in terms of being able to see this in wire 

frame, it is a little awkward to go into the Layer Dialog box every time to change it.  So what you may 

want to do is use a layer combination.  [0:08:25] 

So for example, there's a layer combination here that says "With SEO".  That is set up with a layer called 

SEO.  This is just one of my layer lists, there's nothing special about it other than it's a name that is easy 

to remember for Solid Element Operations.  This layer combination has SEO elements solid.  With SEO 

wire frame, it's set up with a wire frame. So we can easily say for example that I want the floor one also 

to be wire frame here and update it.  [0:08:56] 

Now whenever I switch to this layer combination the floors will become wire frame as well as these 

other elements.  So now you can see how the floor elements are wire frame as well as the ones that 

were used to cut the groove.  Now the layer combination can also be changed, as I hope you know from 

the Quick Options palette, which can be floating or move under the navigator. We can also turn it on or 

off using this little icon here. Quick Options allows you to change the layer combination. So if I go to with 

SEO, you can see how it's showing the Solid Element Operations operators, these elements are used for 

trimming in solid, if I say with SEO wire frame, you can see how it's changed the layer combination 

which now has these in wire frame.  [0:09:46] 

And then I have another one which says without SEO, and that turns off the layer that was designated 

for Solid Element Operations in this model.  Of course it did not turn off the slabs because the slabs 

were not set up in that way.  I'm just going to delete this particular slab so that we have the model back 

into a normal relationship.  Now another quick and simple use for these things is for relating let's say 

roofs and walls.  And you'll notice the wall is trimmed by the roof.  This roof, if I were to tell it to change 

its slope - and let's just trim it way down - the wall follows along.  [0:10:32] 

It has a Solid Element Operation relationship to this.  When I undo it, of course it goes back up.  If I take 

this up higher, take the roof and change its tilt to a higher number - let me just zoom out a little bit - 

we'll see that the wall will be trimmed to that - let me just move this so we can see it - but it won't 

extend, it doesn't grow. The wall is set at whatever height we told it to be.  So the relationship is 



 
 

  Best Practices Course – Week 17 Part 1 – © copyright 2012 by Eric Bobrow 
 
 

enduring, but it doesn't modify the basic attributes, in other words how high that wall is.  If we did want 

to have these walls going up to a higher roof, then we would actually change the height either 

numerically like this or by stretching that wall up.  Let me just undo this back.  [0:11:31] 

Now that relationship is different than the old method that was used for trimming walls to roofs, which 

was to select a wall and a roof together and use the Design menu, Trim to Roof.  In later versions of 

ArchiCAD it's been changed to Crop to Roof.  And I will show you the differences for that.  Remember, if 

I tell ArchiCAD that I want to cancel the operation of this on all targets, then you can see that this wall or 

actually all the walls that it was trimming have now come up above it.  [0:12:18] 

If I select these two walls and possibly the roof together and go to the Design menu, Trim to Roof, it will 

trim the top or the base of that. But now, if I were to change the roof slope you will see that the wall did 

not adjust. So that Trim to Roof, or as it's been called in the latest versions of ArchiCAD, Crop to roof is 

less sophisticated. It does not have an enduring relationship.  So I'm going to undo back here.  Now if I 

want to get the effect that we had of this roof having a long-term relationship with the walls, in 

ArchiCAD 14 and earlier, we would select the roof here and make it the operator, select one or more 

walls and make it make them the target, and instead of subtraction we would choose subtraction with 

upward extrusion and execute.  [0:13:24] 

So the upward extrusion means it subtracts wherever it passes through and everything above.  We 

would do the reverse, which is subtraction with downward extrusion if we were creating walls on top of 

a roof for example for dormer where you want the base of the walls to be trimmed off.  We are going to 

be demonstrating intersection in a moment.  I will be switching over to ArchiCAD 16 to show you some 

differences in the way that the Solid Element Operations work.  But the intersection is going to work the 

same way as well as the addition.  [0:13:56] 

They haven't actually changed the basic methods of operation in any of the versions in ArchiCAD, 

they've been very robust and flexible for use.  So we're going to switch now to ArchiCAD 16. And we 

have a similar project here.  So we look at the building in ArchiCAD 16 and then we look at the site. So 

this is the site terrain; this is just a terrain mesh. And here is a slab that is in that terrain mesh.  That slab 

has a relationship to the terrain with that subtraction with upward extrusion.  What that means is that 

everywhere the slab is and everything above is going to be removed.  [0:14:53] 

So if I want to demonstrate how that works, I can go for example and pull this out. So we can select it 

more easily.  You can see how as I extended it extended it, every place where it extended and all the 

volume above has been cut out.  Now remember that I had in the menu for Solid Element Operations 

under Design menu that it was found underneath Complex Profiles.  It moved down a little lower in 

ArchiCAD 16.  In ArchiCAD 15, it was actually under the Connect sub menu that was introduced in that 

version.  But in ArchiCAD 16 it's back directly under the Design menu.  [0:15:36] 
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And when I open that up, we do have the same controls including the maintain operations here.  But we 

also have a new way of maintaining or controlling the connections.  It's this little grip that you can see. 

It's just a tiny little square with a few squares within it.  When I press down on that, it gives me a popup 

and it allows me to see what else this is connected to.  And if I move the mouse over it, you can see 

there's a little X and I can say I would like to cancel that operation.  [0:16:09] 

Sometimes elements have been trimmed to more than one element and you can selectively choose 

which ones are going to be affected.  And in fact, you can have ArchiCAD highlight the elements that are 

in effect.  Now I will say here I've just cancelled that operation.  So now if I were to select this, let's just 

see how we activate this.  I'm going to make this the operator and its going to control the action. I will 

make the mesh the target and then I will go do the subtraction with upward extrusion. [0:16:43]  

So it's very much the same as the way we'd use for a roof except that it's used in this case for the slab 

volume.  And we say execute, and you can see how that is cut out.  If I were to drag the slab around to a 

new position, we'll see that it carves itself right out of the terrain very naturally.  So we'll just go and 

undo back a few steps to get it back into the same position as before. [0:17:12] 

Now we are going to do a more complex operation here as I've described before in another one of my 

videos. That is creating a path that follows the terrain by doing a combination of Solid Element 

Operations.  So if we look on the floor plan we'll see this curving shape which was drawn with the Spline 

tool here. I can change the shape easily to make it any Spline sort of shape that I want. The Spline tool is 

certainly a nice way to make a smooth curve.  [0:17:52] 

Now I'm going to use the Slab tool and use the magic wand to trace this. And actually that made a little 

piece that was constrained by the other lines here.  So what I'll do is undo that and I'm going to use the 

Window menu, Palettes, Quick Layers and say that I would like to only have this layer turned on.  So I'll 

say other layers other than this one we are going to hide.  And then I will go and use the Slab tool and 

use the magic wand and trace this.  [0:18:32] 

Now it says the layer name Floors is hidden. I'm going to say yes, go ahead and show this. It said it 

couldn't find a region around that point.  Okay so what I need to do is draw a line and close that region.  

Now I can go with the Slab tool and use the magic wand to create a - so let's see. We'll tell it to trace it. 

There we go, third time's a charm. So basically I used the magic wand to trace this area that was just line 

work with the Slab tool.  And if I were to say just show me the selected element in 3D, we'll see that it's 

just this particular flat shape. It is a slab; it has just a uniform thickness.  [0:19:31] 

I'm going to take it up and make it thicker, and then we'll turn on all of the other layers for this.  So we'll 

turn on the layers here.  I've got this view setup with the layer combination for that.  Now you can see 

that this path element is going down into the terrain mesh.  And what I want to do is actually trim it so 

that it does not go above that.  So basically we're going to be following the prevailing grade.  So I'm 
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going to make this the target and select the mesh here as the operator.  So this is the reverse of some of 

the things we've done.  The mesh is going to control the action and the slab is going to be effected.  

[0:20:21] 

But instead of doing subtractions, we are going to do intersections.  What intersection does is it says 

make the target only exist in 3D within the area of the operators.  When I say execute, you can see how 

it has been trimmed down to fit inside the prevailing grade.  Now it does look a little odd because we 

have now both a slab and the terrain mesh in the same volume.  ArchiCAD doesn't complain, but it can't 

really draw a very clear picture there.  So what we're going to do is do a second operation that is 

essentially the inverse or somewhat the inverse of this.  [0:21:04] 

I'm going to select this path slab and give it the operator position, select the mesh as the target so it's 

going to be modified, and instead of doing that intersection I'm going to do a subtraction.  That will 

subtract out the volume of the operator which in this case is the slab from the terrain mesh and 

execute.  And you can see now we've got a very clear relationship between them where the slab exists 

in this volume and the mesh has been cut out around it.  [0:21:44] 

So here we have two operations that were done in a particular sequence.  You can experiment with this 

on your own.  If you did it in the reverse order it would not work the same way.  ArchiCAD does recall or 

record the sequence of operations that you need.  Now if I select this element here, here is that little 

grip that shows the connection information.  And you can see that it's saying that it's the target of this 

other element of the intersect there.  [0:22:20] 

And if I select this one it's saying that it's also a target.  I guess these are, depending on which thing you 

have selected - okay so the mesh actually says that it is the target of different slabs. And whether it's the 

subtraction upward or subtraction. So you can see as I move over this, it's highlighting different 

elements.  So it's a target of the subtraction here, but the other ones that I'm highlighting with this are 

subtraction upward.  And you can see the blue line when I hover over it.  [0:23:02] 

So this little grip here allows you to see and possibly to delete the association between them.  So this is 

more sophisticated than in previous versions before ArchiCAD 15.  So if I were to say stop paying 

attention to the relationship to this slab, you will see how it filled in this gap, because basically it is 

ignoring that subtraction with upward extrusion that made the patio slab come out.  I will just undo that 

so we can get it back and you can see the result there.  [0:23:40] 

So those are some of the differences with ArchiCAD 15 and later with the Solid Element Operations is 

that new grip that has the connection information; and the position of the menu for the Solid Element 

Operations either under the Connect menu or a little lower down here.  We still have the maintain 

operations here, but we have that new connection grip which gives you a little bit more fine tuning 

there.  [0:24:12] 
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To conclude our lesson, I'd like to go over a few of the odd things that may trip you up when you are 

working with Solid Element Operations.  The first thing I would like to point out is that Solid Element 

Operations only work on solid elements, which means they have to have a volume as far as ArchiCAD is 

concerned.  So for example if I select this terrain mesh and I switch it from the solid mode to, for 

example, just being a surface here, you'll see that path disappeared.  It wasn't able to operate in the 

same way with the other solid volume of that slab.  [0:24:53] 

Similarly, if I were to have this method where it looks solid but if we go underneath it we will see that it 

actually is like a little tin can. It’s a  little hard to tell but it's not a solid volume.  We are seeing 

underneath that, so this terrain mesh has to be set for a solid volume in order for these operations to be 

able to take place.  So that's the first thing.  Other elements that could be zero thickness might be things 

like the roof if you set that to zero thickness instead of a volume. It might have problems with Solid 

Element Operations. [0:25:40] 

And sometimes if you work with imported objects that you import from 3D Studio or DWG, they might 

possibly come in and ArchiCAD might think that they are not solid. In ArchiCAD 16 when you are creating 

a morph element, there are ways that you can create it as a solid enclosed volume and other ways 

where can be surfaces. So Solid Element Operations will only work if the element, like a morph, is 

considered a solid volume.  [0:26:06] 

Now another thing that can trip you up a little bit is if you try to work with let's say the Beam tool with 

walls and try to trim things.  I will demonstrate what can be confusing about that.  So if I go to the Beam 

tool and I just draw a beam, now you can see that when I select that beam that the green lines pass 

through this wall.  It's a little bit faint, but you can tell that it's continuing through the wall. And if I select 

the wall, you'll see that the wall actually has a cutout.  [0:26:49] 

So the beam is, even without Solid Element Operations, cutting through the wall. The reason for that is 

that this particular wall, it's priority here - let's just actually moves this dialogue over a little bit - the 

priority for the wall is set at a very low number, number 2.  The wall priority can be anywhere from 0 to 

16, but if we were to look at the beam, it's priority here is number 7 at this point.  If I were to take that 

beam down to a lower number, let's say number zero or something like that, then it will be cut by the 

wall.  [0:27:31] 

A little hard to see because of the faintness of it, but it does have a solid element outline here where it 

meets the wall and starts again beyond it.  And if I change this and move it up, you will see that it 

changes the display just subtly and you can see that it's passing through.  So basically when the beam 

has a higher priority than the wall, it will create a hole in the wall whereas when the beam has a lower 

priority, then the wall will interrupt the beam.  The reason why that's important to know about is if you 

tried to make those grooves like on the side of this building with a beam, you might have a problem 
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because the beam either is already is cutting a hole in the wall or it has a lower priority and the wall is 

interrupting the beam.  [0:28:18] 

Now the only way that beams and walls could relate in terms of Solid Element Operations is if they have 

the same priority. But as I try to make it let's say a two here - actually in this case, it is allowing me. In 

earlier versions of ArchiCAD beams were required to be on odd numbers.  They actually never had the 

same priority as a wall. And walls were required to be even numbers.  But it looks like in most recent 

versions of ArchiCAD they've made that more flexible.  But do pay attention to those priorities because 

you wouldn't be able to do a Solid Element Operation if one is already cutting the other. Then the Solid 

Element Operation is not available, it won't have an effect.  [0:29:05] 

Now you can see that the elements that I've got here in a wire frame that are the groove, you might 

think that they are a beam because they are sort of long shapes similar to most beams, but they are 

actually being done with the Object tool.  This is the cube element here. And this cube is set to have a 

certain length, in this case 24 feet, so about eight meters roughly.  So the cube in the library looks like 

something with symmetrical edges. It can be set up to be any dimension that you like.  [0:29:42] 

So this is certainly one way that you can create just a simple volume for cutting out part of an element 

with Solid Element Operations.  Now you could also use slabs to cut something out of another element. 

Slabs will work just fine, you saw me demonstrating that earlier. But be careful with using beams, 

columns, or other walls, because if there are other walls then the walls might interact.  You know how 

walls will tend to intersect each other.  You put one wall touching another wall and it tries to join if they 

are on the same layer or layers that are on the same priority.  [0:30:21] 

So the simplest and most reliable way to do these sorts of things is to have an object or a slab would be 

the most common ones that I would use for simple volumetric subtractions like that.  Now the other 

little warning I will give you. We don't have a problem in this file for the terrain mesh being complicated. 

It's a pretty small piece of property and only a dozen contour lines roughly that you will see have been 

delineated. But if you have a very complex terrain mesh, perhaps just covering a lot of ground with a lot 

of detail, ArchiCAD's model becomes quite detailed in terms of polygons.  [0:31:13] 

So that in itself takes some effort and calculation for ArchiCAD.  If you start to do a lot of subtractions or 

Solid Element Operations with other elements to that mesh, sometimes you can start to have 

slowdowns or even have some corruption or other problems, depending on how much memory you 

have.  So be aware of that.  And I would say, for example, while you could technically select the entire 

building and subtract it out of the terrain mesh, it's better to select just the slabs so that ArchiCAD is 

only thinking about the slab and its relationship to the mesh rather than having to think about all of 

those walls and other things.  [0:31:56] 
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So sometimes people take a shortcut and they select a whole bunch of elements and subtract them 

from another element.  I would suggest that you pick and choose carefully the things that you are going 

to be relating using Solid Element Operations so that it will not overburden ArchiCAD or cause your work 

to slow down.  So I think this is a good place to stop.  There will be some more videos on this page about 

Solid Element Operations that I will collect from other places from my YouTube channel for example.  

And I will also have a link to the original article that I referred to as well as perhaps a PDF version on this 

page for your reference.  If you have any questions please feel free to post them on the page down 

below.  This has been Eric Bobrow, thanks for watching. 

[END OF AUDIO 0:32:53] 


